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3 Remarks

This manual describes installation procedures with Windows Vista. The installation procedures with
Windows 7, 8, 8.1 and 10 are similar.

Please note that Windows needs local administrative rights to install drivers. Please ask your
administrator, if you do not have these rights.

3.1 License Terms for Lorenz Software

The copyrights for this software remain at:

Lorenz Messtechnik GmbH
Obere Schlossstrasse 131
73553 Alfdorf

Germany

http://www.lorenz-sensors.com

During the software installation, the license conditions will be displayed and must be accepted, otherwise
the installation will be aborted. After the installation, the license conditions can be viewed in menu ‘Help
- Advice’.

3.2 Intended Use

The DR-USB-VS software was designed for the adjustment, control and read-out of a sensor from the
DR3000-series.

Further functions of sensors from the DR3000-series are reception, display and storing of measured
values. Any use beyond this is considered as not intended.

3.3 Designation of the Remarks

If possible remaining dangers emerge during the operation with DR-USB-VS, this will be indicated by the
following symbols in this operation manual:

@3 Note:
Important points to consider

3.4 System Requirements

The operation of DR-USB-VS requires a PC with following systems:
¢ Windows Vista, Windows 7, 8, 8.1 or Windows 10.
o USB-Interface for the connection of the torque sensor
e Maximum two monitors will be supported

Recommended Hardware Requirements:
e Application process without diagram Single-Core from 2,0 GHz
e Application process with diagram Dual-Core from 1,8 GHz
e The higher the measuring rate and the longer a measurement lasts, the higher the required main
storage. The measurement ends as soon as the system does not provide any more free main
storage space.
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3.5 Installation

The Setup “Setup_DR-USB-VS.msi” includes the executable file DR-USB-VS.exe, the driver package for
the USB connection, manuals for DR-3000 and the software DR-USB-VS. During the setup program the
desired additional shortcuts to be installed can be selected first. Then, the installation directory must be
chosen and it must be decided who will use the application on the PC. After finishing the installation
process the USB drivers should be installed.

Please close all programs and back up your data before the installation. All other applications, especially
the virus scanner and the security software, should be closed as well.

3.5.1 Introductory Steps before the Installation

Disconnect all Lorenz USB devices from your PC.

Sign up on your PC with administration permissions.

Remove possibly existing Lorenz USB sensor drivers under System Control ->
Programs/Software by uninstalling the program.

Run the downloaded file ,Setup_ DR-USB-VS.msi".

Follow the instructions.

Start the USB Driver install program within the newly installed program folder, if necessary1.

Y VYV Y V VY

(? The signature is a confirmation, implemented by Microsoft, stating that the driver package is
originally made by Lorenz Messtechnik GmbH.

@ The Lorenz Messtechnik GmbH driver package is deduced from a driver package signed by
Microsoft, whereby only some character strings and the identification features of the Lorenz
USB Sensor Interfaces were adapted.

3.5.2 Connection of USB Devices to a PC'
Now, the driver installation can be closed. Connect the USB device to the PC (you must possibly confirm

the message depending on the operating system). Now the red marked entry below must be found in the
device manager.

@ The initial connection requires administrator rights.

' For the sensors to the RS485 port, the driver installation is not necessary. If you do not install the driver,
skip the paragraphs 3.5.2 - 3.5.4.
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3.5.3 Check-up

The correct installation can be checked in the device manager:

Open the device manager
» Through System control > System - Device Manager
» Alternatively by the Windows key + Pause > Hardware - Device Manager
» Alternatively Start > Execute - devmgmt.msc

If the display shows “Lorenz USB sensor interface Port (COM#)*
when a Lorenz USB device is connected, the driver package
was installed correctly. Under this COM Port, the software can
communicate with the device. If several Lorenz Interface devices
are connected a separate line for each device will be indicated in

the device manager.

3.5.4 Debugging at driver installation

<=y Device Manager EI@
File Action View Help
ez | T = e

+l- Computer -

+\_-u Disk drives

+- B Display adapters
- DVD/CD-ROM drives
+\—J1 Floppy disk drives

+t|3;| Floppy drive controllers
»;--',‘!ﬁ-, Human Interface Devices
+L‘ IDE ATA/ATAP] controllers
+_ Keyboards

+}i{ Mice and other pointing devices

+ Meonitors

+ Metwork adapters

+ ) Other devices

: KT Portable Devices

7 Ports (COM & LPT)

! 15" Communications Port (COML)

1% Communications Port (COM2)

5" Lorenz USB sensor interface Port (COM3)|
12" Lorenz USB sensor interface Port (COM4)|
T5" Printer Port (LPT1)

+D Processors

0%

+c- Storage controllers
1K System devices

57 W

m

Sound, video and game controllers

+)- i Universal Serial Bus controllers

This chart helps to find frequent errors and the measures for debugging.

Error

Possible Cause

Debugging

Device is pointed out under
“?“ or “Other devices =2
Unknown Device/USB Device*

Driver not installed.

Disconnect the device from the
PC. Install driver package.

The initial installation must occur
with administrator rights. Connect
the device to the PC.

Driver installation is aborted
with errors.

Missing administrator rights.

Repeat the procedure with
administrator rights.

Driver installation fails when
connecting.

Missing administrator rights.

Repeat the procedure with
administrator rights.
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4 Preamble

41 Product Description

This operation manual describes characteristics and operation courses of the DR-USB-VS.

4.2 Setup of the Software

The DR-USB-VS consists of following components:

e Configuration possibilities for the VS2

e Storage of sensor-related scaling and adjustment data

e Display for the presentation of measured data (actual value, tare value, minimal value and
maximal value)
Display and storage of measured data evaluations
Presentation of the measured data in a diagram
Storage of measured data in CSV-format (output configurable)
Storage of the diagram in BMP-format (output size configurables )
Print-out of the diagram (output size defined)
Presentation of the sensor information

4.3 Safe and Correct Use

@ Pay attention to the correct sensor adjustment.
@ Pay attention to the correct DR-USB-VS configuration.
@ Choose a significant file identification/prefix when storing measured data.

5 Starting the Software

The software starts only if it identifies a compatible sensor at the USB or RS485 connection. After starting
the executable file, the search for a compatible sensor is displayed. If the search is unsuccessful, check
whether the USB or RS485 circuit at the sensor is connected to the PC and whether the USB drivers
have been installed (if you are working with USB Sensor). Then click on ‘Search again’ to restart the
search for a compatible sensor. If a compatible sensor was found, the sensor-related data will be read-
out automatically. If you want to work with USB sensors only, the search can be accelerated. Use the
Checkbox ,USB only* for this. This setting can be changed here and in Dialog “Sensor Connection” at any
time.

~ ~
DR-USB-VS Lorenz Messtechnik GmbH I& DR-USB-VS Lorenz Messtechnik GmbH Iéj

L:0:1:5

[] Only USB [/] Only USB
Searching for supported sensor... Could not find a supported sensor,
Please connect a supported sensor and search again.
[ Exit Search again ] [ Exit
E-Mail: info@lorenz-sensors.com Technical changes under reserve 090302i.docx
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6 Description of the Operating Mode

The software consists of a menu bar, navigation bar, status bar and a workspace. The functions of the
menu bar comply with the navigation bar. The digital measured value displays of the physical values and
the diagram can be seen under ‘Operating Mode > Meas./Diagram Mode’. In the workspace the

consolidated dialogs are displayed under ‘Operating Mode’.
e Adjust. Mode (see chapter 6.2)
e Meas./Diagram Mode (see chapter 6.3)

Switching between the dialog boxes can be done through the navigation bar as well as through the
equated menu bar. Adjustment changes in the dialog box will be accepted without confirmation.
All adjustments are stored when ending the application and will be loaded when the application gets

restarted.

The status bar displays current status information of the application

‘Ready for use. Sensor connected’
‘Sensor disconnected’

‘Measure...’

‘wait for trigger start event’

o ‘Measure! Wait for trigger stop event’

Furthermore, information from the menu bar and navigation bar through the control elements as well as

the storage progress in a CSV-file are indicated in the status bar.

6.1  The Menu Bar/Navigation Bar of the Program

6.1.1 File > Save Measvalue (Shortcut ‘Ctrl+M’)

From here, the measured data of the last measurement® are
stored in a CSV-file. The output format of the file is adjustable in
dialog box ‘Operating Mode - Adjust. Mode -
Documentation’ under the headline ‘Output measured values’
(see chapter 6.2.4.1 Documentation - Output Measured
Values). In the first column of the CSV-file, the measured values
are numbered ascending. The output of columns two to
maximum four will be taken over by adjustment ‘Operating Mode
- Adjust. Mode > Measure Adjust.’ under the ‘Diagram’
headline. Here, each adjusted physical value will be written into
the file. The sequence: [X-Axis], [Y1- Axis], [Y2- Axis], [Y3- Axis].
Caution: all output adjustments must be carried out
before the measurement.
@ Caution: a CSV-file is a text file for the storage of
simple structured data. The abbreviation CSV stands
for Character Separated Values or Comma
Separated Values. These values are separated from
each other by special delimiters, e.g. by comma,
semicolon. A CSV-file can be started by double-click
in Excel®. The denotation of list/field/line-ending
marks are not explicitly determined. The definitions
under 6.2.4.1 Documentation - Output Measured
Values - ‘End of line character’ / ’Column
separator’ / 'Decimal separator’ must optionally be
adjusted in DR-USB-VS or in your spreadsheet. For
this, see the manual for your spreadsheet.

Headline:
easure OC 1

Address

Larenz Messtechnik GmbH
Obere-Schloss-Strasse 131
73553 Alfdorf

Germany

Cormment

Processor: P. Sample

Person in Charge: H. P. Ross
Quality manager: M. Timberlane
Public Relation: Y. Lescadres
Transportation: | Wants

Measurement informations:

Sensortype: | DR-3000
Serial number: 2008
Upper range value: |50.0 M-m
Accuracy class:|0.10%
Uncertainty of measurement: 0.05%

Sampling rate: 1/sec
moving average Torque: |1
maoving average Speed: 1
maving average Power: 1
Impulses per revolution: 360
Factory adjustment: 11/13/2008 inactive
User adjustment: | 1202/2008 active

Trigger - Start - Source: | Speed
Trigger - Stop - Source: Measurement duration

Start (Date Time): 2/6/2009 11:58:49 AM

# Torgque (N-m)

0.002 N-m
-0.020 MN-m
0.004 N-m
-0.746 M-m
0.582 N-m

Speed (1/min) Power (kW)
209 1/min  0.000 kY
-182 1/min - 0.000 ki
-155 1/min - 0.000 kY

-8 1fmin 0.007 kW
7 1fmin - 0.000 k¥

0.007 kw

0.001 ki

0.001 kK

0.000 ki

0.001 kw

0.000 kW

0.000 ki

0.346 M'm
0.408 Ne-m
0.266 N'm
-0.028 M-m
9 -DIEEMNm
10 0.016 N-m
il 0.036 W'm

23 1fmin
22 1fmin
28 1fmin

1 1/min
-36 1/min
-15 1/min

0 1/min

@ mm e W= O

Stop (Date Time Duration): | 2/8/2009 11:52:00 AWM (00:00:11)

2 Measurement: recording of a measured value series in the configured measuring rate of Start]...] to

Stop [...].
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6.1.2 File > Save Diagram (Shortcut ‘Ctrl+D’)

From here, measured data of the previous measurement2 can be stored in a BMP-file.
Predefined output variables can be adjusted in ‘Operating Mode 2> Adjust. Mode - Documentation’
under the ‘Output diagram’ headline in box ‘Memory size’. There are following possibilities:
e max:
Adjustment is only available, if the running system recognizes two monitors. On these two
monitors, the diagram is maximum size stretched and stored.

e normal:
The diagram is stretched to approx. screen size and stored.
e min:

The diagram is stretched to approx. 800x600 pixel of the monitor and stored.

e Window:
The diagram gets stored the same way as it was adjusted by the user.
Any measurement range can be selected by the range slider and the interval slider.

Diagram @

| S - Range slider

Torque T
[H-em]
100
50 m
0.0
b

5.0

- Interval slider

The diagram has a context menu. By right-click on the mouse key, following functions are available:

e Zoomin:
The mouse pointer becomes cross-shaped. By pressing the left mouse key and moving the
mouse in the diagram, a rectangle appears which can be zoomed by releasing the mouse key.

e Zoom out:
The diagram indicates the complete range of the previous measurement.

e Scrolling:
The mouse pointer becomes cross-shaped with arrows. By holding the left mouse key in the
diagram, the curve can be shifted.

e Grid on/off:
The stroke lines in the diagram form the raster. By this function, the stroke lines can be faded
in/out.

e Show Legend:
The legend indicates the physical variables and their units. With this function it can be faded
in/out.

@ Caution: When storing the diagram, only the current illustrated part of the measurement will
be stored.

E-Mail: info@lorenz-sensors.com Technical changes under reserve 090302i.docx
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6.1.3 File > Print (Shortcut ‘Ctri+P’)

@ Messung

This function enables the print-out of the diagram with print time, configurable
heading, configurable remark, configurable address as well as a customized
logo (picture to the right).
The user can carry out the configuration by the navigation bar “documentation”.
Line breaks in remark and address are converted into blanks.
Following restrictions are valid

e The heading is restricted to 20 characters

e The remark is restricted to 57 characters

e The address is restricted to 82 characters

In order to contain a customized logo, it must be stored under
the file name “Custom_Print_ Logo.bmp“ and copied to the folder
“%USERPROFILE%\AppData\LocaI\Lorenz”s.

Caution: the recommended properties of the “BitMap ,Custom_Print_Logo.bmp* are:
e Resolution: 160 pixel *160 pixel
e Maximum bit depth: 32bit

If there is no file named “Custom_Print_Logo.bmp* placed in the folder
“%USERPROFILE%\AppData\Local\Lorenz*, the Lorenz logo will be contained.

6.1.4 File > Exit (Shortcut ‘Ctrl+E’)

Terminates the program. If the program is still in the measuring mode while terminating, the measurement
will be ended. If automatic storage is adjusted (see chapter 6.2.4.1 Documentation = Output Measured
Values and chapter 6.2.4.2 Documentation = Output diagram) it will be executed before the program is
terminated.

6.1.5 Operating Mode

This umbrella term contains all sensor-specific adjustments ‘Adjust. Mode’ as well as the
‘Meas./Diagram Mode’. By selecting a mode it will be displayed in the workspace. Following dialog
boxes can be displayed:
¢ Adjust. Mode - Sensor Connection (see chapter 6.2.1)
Adjust. Mode - Sensor Information (see chapter 6.2.1.2)
Adjust. Mode - Measure Adjust. (see chapter 6.2.2.2)
Adjust. Mode - Documentation (see chapter 6.2.3.6)
Adjust. Mode > Sensor Adjustment (see chapter 6.2.5)
Meas./Diagram Mode (see chapter 6.3)
When restarting the software it will start with the previous active dialog box. The next menu can be
entered via the shortcut ‘Ctrl+TAB’; the previous menu can be entered by ‘Ctrl+Shift+TAB’

® The environment variable %USERPROFILE% stores the current Windows® path of the
registered user.
This path is defined during the Windows® installation and can be changed in the system control and
through the group guidelines.
The user name is also included in the path...
As default, this path under Windows® 7 reads:
C:\Users\<Username>

E-Mail: info@lorenz-sensors.com Technical changes under reserve 090302i.docx
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6.1.6 View

The control elements under ‘View’ are responsible for fade in/out of bars and displays as well as setting
back the windows view. In the menu/navigation bar a checkmark indicates faded in/out bars and displays.
The digital displays and the diagram can only be switched in the measuring and diagram mode, otherwise
they are grey (disabled). While executing ‘View - Reset Views’ (e. g. via the shortcut ‘Ctrl+R’) the digital
displays, the diagram and the main window are set back to original condition.

6.1.7 Language

Here, the language of the DR-USB-VS can be adjusted.
All indications of the application are changed in accordance with the selected language.
Following languages are supported:

e German
e English
e French

At restart of the software, the previous adjusted language will remain.

6.1.8 Help = Info

Here, the version number of the software is indicated.

f Info &JW

Copyright © 2008-2016 Lorenz Messtechnik GmbH
Version 2.07

L Advice Lé]
License Conditions -
1. Terms
Licensee:: Customer
Licenser: Lorenz Messtechnik GmbH L
Obere Schlossstrasse 131 3
73553 Alfdorf
Germany
Software: Executable programs with corresponding files as well as the

documentation, These can getin the possession of the licensee in
different ways, e.g. by download from the internet pages of the
licenser, by the purchase of a data medium or in another way.

2. Property
The software is property of the licenser, The licensee exdusively receives the right to
use the software in unchanged form.
All owner permission and industrial property rights of the software remain with the
licenser and are protected by copyright laws and international copyright contracts and
contracts for the protection of intellectual property. The software is licensed and not
sold.
The licensee can only receive owner permission onto the data medium which
includes the software.

6.1.9 Help > Advice .

License
The licenser grants the licensee the restricted, nontransferable right to use the
software on an arbitrary number of own computers in unchanged form.

Contains the license conditions for this software, the o e s oF o srers s i .
address as well as Website and E-mail links. extended functions of the softnare can be used. i
Internet:  hito:/ A lorenz-sensars. comd

E-Mail: infol@lorenz-sensors.com
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6.2 Configuration Mode

The configuration mode contains all sensor-, measurement- and documentation adjustments as well as
the output of sensor information. The adjustment dialog boxes are shown in the operation range through
the menu/navigation bar. In the following chapters, the adjustments are introduced and the functions are
explained.

6.2.1 Sensor Connection

(E) DR-USB-VS Lorenz Messtechnik GmbH = |
File Operating Mode View Language Help
Navigation Bar £ Sensor Connection
Interface Baud rate Serial number Upper range value Statortype State
Communications Port  [COM1] n.a. n.a n.a. not available
PCI Communications Port [COM22] 115,2k -1 220.0 N'm DR-USB (Rev.: 6) available
Larenz USE sensor interface Port  [COM23]  115,2k 1234680 50.0 N-m DRAUSE (Rev.: &) active
_ Operating Mode Larenz USE sensor interface Port [COM25] n.a. n.a. n.a. not available
= s Adjust. Mode Lorenz USE sensor interface Port  [COM27] n.a. n.a. LCY-USB2 (Rev.: 7) not supported
T 5 Ser;sor Bonnecity Larenz USE sensor interface Port  [COM3] 230,94k -1 n.a. DRAUSE (Rev.: 4) available
7 . Lantronix CPR Port [COM30] n.a. n.a. n.a. not supported
%4 Sensor Information
Measure Adjust.
Documentation
%% Sensor Adjustment
..[#] Meas./Diagram Mode
3 View
iagram
..[7] Mavigation Bar
..[7) Status Bar
...[ax Reset Views
_+ Language
B Deutsch
..k English
..A 1 Francais
4 Help
-CD) Info
LD Advice
TEEE ] use onl = Only previously
= pee a y = available
4 n 2
Ready for use. Sensor connected Fri  05/20/2016 (01:56 PM
L

This software only supports Lorenz USB/RS485 sensors with integrated quadrature encoder resp.
integrated speed/angle measurement (e.g. DR-3000/29xx-series) If a Lorenz USB sensor is connected
with a PC, it will be automatically activated by the DR-USB-VS.

The DR-USB-VS can only activate one sensor at a time. The selected sensor gets activated by double-
click in one of the displayed lines where the ‘State’ is shown as ‘available’.

Sensors in columns with ‘State’ ‘not available’ cannot be activated. The State ‘not available’ means that
the DR-USB-VS could not open or activate the interface, or that the sensor did not respond. If another
process or application takes access on the desired interface, this access should be terminated.

Search for free interfaces by the ‘Update’ key.

Status ‘not supported’ indicates incompatible Lorenz sensors.

The list gives further sensor information such as baud rate, serial number, final value of measuring range
and stator type.

The deactivation of a sensor occurs either by the activation of another sensor or by double-clicks on the
active sensor. When deactivating, the COM interface gets released and can be used by other
applications.
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6.2.1.1 Sensor Connection >Baud Rate

(E) DR-USB-VS Lorenz Messtechnik GmbH You can change the baud rate with a simple
click in the column Baud rate on the
corresponding line of the Interface (see

File Operating Mode View Language Help

b example left: ,Interface’ ,PClI Communications
N covdrare | s POt [COM 22]°) between 115200, 230400 and
Communications Port [COM1] n.a. 921600 Baud rate.

PCI Communications Port [COM22] |115r2-'. = =1 ) .
Lorenz USE sensor interface Port  [COM23] [RRETEE “ [ 1234 _BaUd Rate Maximum AdJUStabIe
Lorenz USE sensor interface Port  [COM25] S;Dlgt n.a. in Baud Measure Rate
Lorenz USB sensor interface Port  [COM27] - n.a. 115200 2500/5
Lorenz ITISB sensor interface Port [COM3] 2304k -1 230400 5000/s
Lantronix CPR. Part  [COM30] n.a.

921600 20000/s

@ The changed baud rate will be permanently stored in the Sensor. This adjustment apply to the

interaction with other applications.

@ The maximum adjustable Measure rate depends of the selected baud rate and the used
processor of the PC.

@ Each sensor does not support all available baud rates. The software supports you to get a
baud rate the sensor supports.

6.2.1.2 Sensor Connection 2> Update

During this update (i.e. after you click on the button "Update", but also after connecting or disconnecting a
USB connection or with the change of the baud rate) all compatible interfaces (or predefined subset of
them) which are registrated in the PC will be checked and read-out. A subset can be defined using the
check boxes "USB Only" or "Only previously available". Please use these restrictions if desired for
accelerating the search. In the case of connecting or disconnecting a USB port, the setting “Only
previously available” will be ignored.

Here, the baud rate is detected and automatically adjusted. Furthermore the complete sensor data and
sensor information will be read-out. The course of the update will be visually presented (see image).

(E) DR-USB-VS Lorenz Messtechnik GmbH =HRCE X
File Operating Mode View Language Help
Navigation Bar X Sensor Cornection
— File
B e Interface Baud rate Serial number Upper range value Statortype State
. Save Di " Communications Port [COM1] n.a. n.a. n.a.
é Print PCI Communications Port [COM22] n.a. n.a. n.a.
Bk Lorenz USE sensor interface Port  [COM23] n.a. n.a. n.a.
__ Operating Mode Lorenz USE sensor interface Port  [COM25] n.a. n.a. n.a.
g 5 Lorenz USE sensor interface Port  [COM27] n.a. n.a n.a.
=i~ _s+ Adjust. Mode
Lantronix CPR Port  [COM30] n.a. n.a. n.a.

%% Sensor Connection
*¢ Sensor Information
(4] Measure Adjust.
[#] Documentation

i..%f Sensor Adjustment
[ Meas./Diagram Mode
i View

@ Caution: The state of SI-RS485 devices must be updated manually with the button “Update”
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6.2.2 Sensor Information

@ DR-USB-VS Lorenz Messtechnik GmbH | = | B [

File Operating Mode View Language Help

Navigation Bar £ Sensor Information

_ File Comman

----- B Save Measvalue Rotor Stator

Pri Sensortype: DR-3000 Sensortype: DR-3000
""" & Print Serial number: 92947 Serial number: 92947
_ Operating Mode ) _ID: 1 ) _ID: 7
S Adjust. Mode Revision: & Revision: 1

----- %% Sensor Connection

----- §5 Sensor Information
| Measure Adjust. Torque
Upper range value Accuracy dass Uncertainty of measurement

| Documentation
----- % Sensor Adjustrent 50 cM°'m 0.1% n.a.
----- [®)] Meas./Diagram Mode

— View Factory adjustment

- _ Digital Views Adjustment created at:  04/02/2013 active

..... £ Angle User adjustment

""" (05 s Adjustment created at:  n.a. inactive

----- 7% 10/ NIO-validation

----- i3 Diagram Angle/Speed
Navigation Bar

Status Bar

----- Reset Views

_+ Language

..H8 Deutsch

o= English

----- 1 1 Francais

Impulses per revolution: 360

Ready for use. Sensor connected Wed 11/20/2013 01:28 PM

This dialog box shows information and characteristics of the activated sensor. The DR-USB-VS reads the
data during the sensor activation. If no sensor is activated, all indications are ‘n.a.” (not available). If the
uncertainty of measurement shows ‘n.a.’ it means that the uncertainty of measurement is not stored in the
activated sensor. This value is determined in % from a Lorenz proprietary calibration or a DKD calibration.
The detected value can be stored in the active sensor in menu ‘Sensor Adjustment’ under ‘Store
uncertainty of measurement in the sensor’.

Lorenz sensors have two storage spaces for adjustment values, an unchangeable proprietary block and a
changeable user adjustment block. If a user adjustment has been accomplished successfully in menu
sensor adjustment, this adjustment is active in the sensor and indicated ‘active’ in the sensor information
with creation date. The factory adjustment is deactivated by this. (Further information can be found in
chapter 6.2.5 Sensor Adjustment)

At user adjustment, the condition ‘active’ is also marked with “*’,in case this adjustment uses the same
factors as the proprietary adjustment. This is the case at subsequent filing of the uncertainty of
measurement at active proprietary adjustment.

6.2.2.1 Sensor Information 2 Common

This shows the general information of the connected sensor.

E-Mail: info@lorenz-sensors.com Technical changes under reserve 090302i.docx
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6.2.2.2 Sensor Information > Channels
These fields contain information of the respective measuring channel.

Angle and speed cannot be selected simultaneously. Is speed selected, power can be selected as an
additional channel.

6.2.3 Measurement Adjust.

(E) DR-USB-VS Lorenz Messtechnik GmbH EE

File Operating Mode View Language Help

Navigation Bar £ Measure Adjust,
_ File Measured variable
----- B Save Measvalue Type Sampling rate
""" & saveDiagram Torque Angle | Speed Power .'»lEDDfseciv
----- & Print
..... Exit
_; Operating Maode Display
511 Adjust. Mode Decimal place Unit Average Sign

i 3% Sensor Connection Torgue: |l v| |mN'm 'l |51-‘-i '| |+ v|

% SensorInformation Speed: |D v| |lfn'|in v| |l v| |+ v|
Measure Adjust.

Documentation HOIER |3 v| |W v| |5]“-’l v| |+ v|
ﬁc Sensor Adjustment | automatic configuration of dedmal point as well as the unit for torque and power
----- [E] Meas./Diagram Mode .
Diagram
_; View

21 s Digital Views X-axis: | Time - Reducing the sampling rate by averagingvia 1 value.
. {3 Torque Y 1-axis: | Torgue ¥ | YZ2-axis:|Speed ¥ | Y3-axis:|Power -

£ Angle

£7% Speed T;ffir
.
i Power
L S-:-ur-:e:lTorque hd |Dire-:tinn:|over run A |1.-'alue: 10 mN'm
i 3 IO/ NIO-validation
""" f:} Diagram Additional program to execute (full path): @
..... 7] Mavigation Bar Sto
Status Bar 5 i . 7500 M ints
..... S nurce.lMeasurement duration v| 3 sec( easure points)
_ Language it
Additional program to execute (full path):
.. Deutsch @
A M
-fate English 10/MNIO-validation
..... F i
#1 Francais First Condition Second Condition
- Help Measured variable ] Measured variable
LD Info |
; Torgue i | b
LD Advice
Lower limit value Upper limit value Lower limit value Upper limit value
44 mm 4 mNem e mim
Pl 1 I
Ready for use. Sensor connected Wed 11/20/2013 01:40 PM

In this dialog box all measuring adjustments can be viewed and changed. The measurement adjustments
are subdivided into measured variable, diagram, trigger and OK/NOK-evaluation. Except for the serial
number, these adjustments will be accepted without confirmation.

The adjustments in Measured variable>Type, Measured variable>Sampling rate, Measured
variable->Display and Measured variable>Diagram->Reducing the sampling rate by averaging via
X values are sensor related data and are saved in the sensor. Herewith an automatic configuration of the
software to the connected sensor is warranted.

When the application is finished, the previously not mentioned values are stored in the Windows registry
under the logged in user and restored after a restart of the software.
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6.2.3.1 Measurement Adjustments 2> Measured Variable > Type

This workspace is for the configuration of the measured variables which were recorded by DR-USB-VS.
Torque can always be recorded, but angle of rotation and speed variables cannot be recorded at the
same time.

The measurement adjustments are partitioned in measured variable, diagram and trigger. Before the
adjustment it must be determined whether angle of rotation or speed (including mechanic performance)
should be measured. This adjustment is selected accordingly in ‘Measured variable - Type’.

The switch-over takes a short moment because the sensor gets configured via the interface. After the
switch-over the control elements and their contents will accordingly be adopted in ‘Measured variable >
Display’, ‘Measured variable - Diagram’ and in ‘Measured variable - Trigger'.

(? Caution: The switch-over between angle of rotation and speed is only possible if a Lorenz
USB sensor from the DR-3000-series has been connected. Otherwise, the control elements in
‘Measured variable - Type’ are deactivated.

6.2.3.2 Measure Adjust. > Measured Variable - Sample Rate

Following measuring/sampling rates are selectively adjustable: 2500/sec, 1250/sec, 1000/sec, 500/sec,
250/sec, 200/sec, 185/sec, 100/sec, 50/sec, 33/sec, 25/sec, 20/ sec10/sec, 1/sec, 50/min, 20/ min, 10/
min, 1/ min.

6.2.3.3 Measure Adjust. > Measured Variable 2> Display

The configuration display varies depending on the adjustment in ‘Measured variable - Type’ whether
speed or angle of rotation is active.

Display Display

Decimal place Unit Average Sign Decimal place Unit Average Sign
Torque: [2 Jvm ) [s2 ~] [+ -] Torque: [2 < m ][5z [+ -]
Speed: |0 v||l,|"min '||1 '||+ '| Angle: |2 vHD v||1 v||— v|
Power: [3 w52 ~] [+ -]

/| automatic configuration of decimal point as well as the unit for torque and power | automatic configuration of decimal point and the wnit for torque

The adjustments in ‘Measured variable > Display’ determine the output and display of the physical
variables. Here, for each physical size the amount of positions after the decimal point, the unit, the
moving average value and the leading sign can be configured.

By the automatic configuration, depending on the read-out sensor data, the number of positions after the
decimal point, the unit of the torque sensor and the unit of the mechanic performance (if active) can be
adjusted.

Up to four positions after the decimal point can be displayed for each physical variable. This adjustment is
being considered in the digital displays, in the diagram and the output of the CSV-file. German, English
and American units are available for the determination of a physical variable unit.

The conversion to the adjusted unit will be executed by the software automatically. A moving average
can be established for any physical variable over 1 to 512 values with a gradation in raster 2" of the
adjusted measurement rate.

The leading sign of the physical variable is predefined in the sensor. By adjustment in ‘Measure variable
- Display - Sign’ the leading sign can be changed.

6.2.3.4 Measure Adjust. > Diagram

Diagram Diagram
X-axis:| Time - Reducing the sampling rate by averaging via 1 value. X-axis: | Time - Reducing the sampling rate by averaging via 1 value.
Y 1-axis:| Torque ~| ¥2-axis:|Speed » | Y3-axis:| Power - ¥ 1-axis: ‘ Torgue - | YZ-EXiS:|AngIE - |

In input box ‘Reducing the sampling rate by averaging via X values.’ it is possible to decrease the
measuring points which should be saved by entering a value for X. Hence, the adjusted sampling rate
e.g. 200/sec at X=10 will be reduced to 20 measured values in a file. When reducing the sampling rate,
an averaging over the last X values is carried out.
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@ The adjustment ‘Reducing the sampling rate by averaging via X values.” Has no effect on
the illustrated values in the digital displays.

(? The adjustments under 6.2.3.3 Measure Adjust. > Measured Variable - Display »>
Average of the individual physical sizes and the adjustment ‘Reducing the sampling rate
by averaging via X values.” act cumulatively.

The adjustment of this configuration should be started with the X-axis. Here, it can be selected to record
the measured values via time/, torque/, angle/, speed or the mechanic performance. Resulting from the
adjustment of the X-axis, the application updates the number of Y-axis as well as their selectable
contents. All combinations of measuring variables can be illustrated in a diagram.

@ Caution: The measured values are written in a CSV-file with the physical variables which

were adjusted here. The writing sequence is: [X-axis], [Y1-Achse], [Y2-axis], [Y3-axis]. If a Y-
axis is not required, it is also possible to set them “Off’. Nevertheless, the application assures
that minimum one variable on the Y-axis has not been set “Off”.
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6.2.3.5 Measure Adjust. > Trigger

Course:
1.

oakwn

Select a start event.
Select a stop event.
Enter trigger key.

Actuate a trigger start event.
Actuate a trigger stop event.

Measurement recorded.

Initial state

No

| Trigger

.| Measure OFF ]

Trigger O

OFF [
grey

Trigger pressed?

Yes

\ 4

No

Measure OFF

( \ 4 \

Trigger ON
Trigger 5:6:5 yeI low flash

Triggerstart event fulfilled?
OR
Measure Start pressed?

Y

Yes

\4

No
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In the previous signal flowchart, the general course of measurement by means of a triggering is
described. The activation button ‘Trigger’ can be found in the ‘Meas./Diagram Mode’ underneath
‘Measure Stop’. The software triggering consists of two events which are adjustable according the
requirements:
e Triggerstart > Source:
o Off/Measure Start:

Entering ‘Measure Start’ release

the tl’iggerstart eVent. (Th|S fUnCtion Source:| Systemtime ¥ | 11/20/2013  13:43:06 {(MM/ddfyyyy HH:mm:ss)
to Start an eVent can aISO be Additional program to execute (full path): @

entered in the following sources).

o Torqe(M)/ Angle(a)/ Speed(n)/ Performance(P):
See chapter 6.2.3.5.1 Triggering to a Physical Variable (M, o, n, P ).

o Systemtime:
The application shows an input box where the date and the time of the measurement
start can be adjusted. The adjustment is limited to the current time plus 15 seconds.
These values must be re-adjusted after each measurement; otherwise the following
measurement will start immediately by pressing the trigger, because the previously
adjusted time lies in the past.

o Start delay:
After the trigger-start-event, the start of the measurement series can be delayed by the
specified time (posttrigger). Allowable values are Oms (no delay), 20ms — 5000ms.

o After executing Start/Stop: through these fields, actions can be assigned to both trigger
events.
After the event, evaluation and storage actions, the program specified in this field will be
executed.
Any executable files and batch files are admissible. These files can be manually specified
with full path or selected via requester through the folder icon.

o Triggerstop =2 Source:
o Off/Measure Stop:
Entering ‘Measure Stop’ release  sw»

the triggerStOp event (Th|S fUnCtion Source: | Measurement duration 3 sec (7500 Measure points)
to stop an event can also be entered Additional program to execute (fll path): =

in the following sources).

o Torqe(M)/ Angle(a)/ Speed(n)/ Performance(P):
See chapter 6.2.3.5.1 Triggering to a Physical Variable (M, o, n, P).

o Measurement Duration:
For this selection an input box is available. The time unit (seconds, minutes) is taken from
the sampling rate.
The number of measurements is calculated and displayed by the application next to the
input box.

o Number of Measurements:
For this selection, an input box is available to indicate the number of measuring points.
The measurement duration is displayed and calculated next to the input box. The time
unit (seconds, minutes) is taken from the measuring rate.

o After executing Start/Stop: Two trigger events can be assigned actions through these
fields.
After the event occurrence and/or evaluation and storage actions, the program specified
in this field will be executed.
Any executable files and batch files are admissible. These files can be manually specified
with full path or selected via requester through the folder icon.

@ Remark: The source adjustments of trigger start and trigger stop can be optionally combined

with each other.

@ Remark: The adjustments “Measurement duration” and “Number of measurements” refer to
the adjusted sampling rate and not to the reduction of the sampling rate.
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6.2.3.5.1

The picture on the following page shows an
example of how a measurement by means of
triggering can be recorded to a physical variable. At
this triggering not only the value of threshold (Yoyer;
Zower) Of @ physical variable, but also a direction
must be indicated. In the example diagram, the
direction ‘over run’ is triggered. This means that

Triggering to a Physical Variable (M, a, n, P )

Trigger
Start

Source: | Systemtime ~| 11202013

Additional program to execute (full path):

13:48:06 (MM/ddfyyyy HH:mm:ss)

oY

Stop
Source: | Measurement duration

Additional program to execute (full path):

3 sec (7500 Measure points)

&y

the measured value must fall below the hysteresis

value before the trigger will react to the over run of the value of threshold. On the opposite, the
adjustment ‘under run’ means that the measured value must exceed the hysteresis value before the
trigger reacts to the under run of the value of threshold. The grey-framed area of the example diagram
equals the display in the diagram of the DR-USB-VS after the measurement course. This area can be
stored in a CSV-file.

Yover = Triggerstart value of a physical variable with directional adjustment ‘over run’

Zover = Triggerstop value of a physical variable with directional adjustment ‘under run’

At over run, the value of the hysteresis is deducted from the value of threshold; when below, it will be
added. The calculation of hysteresis for each possible physical variable is shown beneath the example
diagram on the next page.

6.2.3.5.2 Diagram Example
M/o/n/P ) i Lo
A n :
Y over : Hysteresis
Triggerstart -
. event ]
3 : >t
3 E p—
Triggerstop - - -
] event 1 /
Z over ‘!/ Hysteresis
6.2.3.5.3 Calculation of Hysteresis
MHysteresis = MMeas.rangef.s. ’ 0’01 ) KMUW
aHysteresis = 32 ) KaU i
nHysteresis = 20 ’ KnU i
M cas.rangef.s. H
Hysteresis — P 6g0f — -30- KPUnil ~ MMea.v.rang@f.S. ’ 57236 ’ KPL'niI
Imperative is {M Measrangef.s. 1 N m}

090302i.docx
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Constant-tables which are necessary for the calculation of the hysteresis. Use the respective unit
factor of the physical variable which you have adjusted in the application.

Adjustment KMW Adjustment Knm Adjustment KPU:m
kN-m 0,00100000 1/min_ {1,00000000 MW 0,00000100
N-m 1,00000000 rad/min |6,28318531 kW 0,00100000
N-cm 100,00000000 1/s 0,01666667 w 1,00000000
N-mm |1000,00000000 rad/s ]0,10471976 hp 0,00134102
ozf-ft 11,80099400 rem 1,00000000
ozf-in 141,61193000
Ibf-ft 0,73756210
Ibf-in 8,85074580

Adjustment Kau,m
° 0,25000000
rad 0,00436332

6.2.3.6 Measurement Adjustments > OK/NOK Evaluation

These settings affect the evaluation of a measurement 10/MI0-validation

series. After a trigger stop event occurs, the max. values First Condition

of these measurement series are determined and Measured variahle 7
compared with the stored limits. In order to obtain an OK-

display, the max. value of a measurement series must be |T°“:|“E i

above the lower and below the upper limit. L= e T Upper limit value

If two conditions are defined, both conditions must meet

the OK criteria for a total OK-display. 41 mi°m 4“4 mi°m
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6.2.4 Documentation

@ DR-USBE-VS Lorenz Messtechnik GmbH

File Operating Mode View Language Help
Navigation Bar ®

.+ File

_+ Operating Mode
= _; Adjust. Mode

§ Sensor Connech on

. Documentatmn
L.t Sensor Adjustment
..... E] Meas./Diagram Mode
—] View

= = Digital Views
e Torgue
-3 Angle

- 7% Speed

b % Powver
b3 10/NIO-validation
..... {:} Diagram

..... [A Mavigation Bar
..... Status Bar

..... Reset Views
_ Language

Documentation

Output measured values

End of line character:

Automatic storage: [Save all measurements into one file

v lerAa -

Target directory: @ Prefiy: TAB

Output I0/NIO validation

Column separator:

' -

Automatic storage: [Save each measurement with an own index

"] Decimal separator:

Target directory: ] Prefic: ERG

Additional information show hide

[ Headline Uncertainty of measurement Date f Time
[ Address [ comment Physical unit
Output diagram

Automatic storage: [Save any diagram with an own index

Target directory: @ Prefix: DGM

Memory size: (normal ~ «

Additional information
Headline

DC Motorenmessung bis 5 M'm

Address Comment
.. Deutsch -
— . Lorenz Messtechnik GmbH Umgebungstemperatur 23°C
-sata English Obere Schlossstrasse 131 Priifstand K7638
----- B0 Francais 73553 Alfdorf
Verantwortich: Ing. K. Muster

il —n Deutschland

(D Info

LD Advice
4 1 3

Ready for use. Sensor connected Wed 11/20/2013 02:01 PM

Here, the user can carry out documentation configuration. The adjustments refer to the storage of
measurements as BMP and/or CSV-file as soon as printing the diagram.
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6.2.4.1 Documentation > Output Measured Values

o Automatic Storage:
The storage of the measured value into an output file can occur automatically by the software.
Three adjustment possibilities are selectable for this:

o None: The automatic storage is disabled.

o Save all measurements into one file: This option files each measurement in the same
CSV-file at the end. The name from field prefix is used as the file name. The file gets
stored in the registered target directory.

o Save each measurement with an own index: This option creates a separate CSV-file
at the end of each measurement. The file name consists of the prefix and the index

YYYYMMDDHHmmss#### (‘##### number beginning with leading zeros 0000; 0001; ...)

@D The path length is limited by the running system.

&

Target Directory:

The target path is registered under ‘Target directory’ (Standard
adjustment ..\<user name>\My documents\DR-USB-VS). Instead of
this, you can click on the folder and select a directory.

Prefix:

Please enter the file name which is used for the automatic storage in
this input box. (Further details about file name/prefix can be found
under headline “Automatic Storage”.

(Shortcut ‘Ctrl+M’).

6.2.4.2 Documentation - Output diagram

Automatic Storage:

Remark: Definition “Measurement” see chapter 6.1.1 File = Save Measvalue

Search folder =)
Please select a folder from the list:
Offentlich
4|8 Computer
&, Lokaler Datentrager (C:)
(s HP_RECOVERY (D:)
(s 05_TOOLS ()
i DVD-RW-Laufwerk (F:)
2 Voll (\\E0912) (G3)
59 Vol2 (\E0912) (H:)
Kiicken Sie auf das Symbol neben einem Ordner, um
Unteror NZUZ n,
Neuen rdner erstellen Abbrechen

The software can automatically store the diagram in an output file. For this, two adjustment

possibilities can be selected:
o None: the automatic storage is disabled.

o Save any diagram with an own index: this option creates a separate BMP-file at the
end of each measurement. The file name is a combination of the prefix and the index
YYYYMMTTHHmmss##HH (‘#HH#E number beginning with leading zeros 0000; 0001; ... ).

(? The path length is limited by the running system.

&

(Shortcut ‘Ctrl+D’).

Target Directory:

The target path is registered in ‘Target directory’ (standard
adjustment ..\<user name>\My documents\DR-USB-VS). Instead of
this, you can click on the folder and select a directory.

Prefix:

Enter the file name which shall be used for the automatic storage in
this input box (further details regarding file name/prefix can be found
under the headline ‘Automatic storage’).

Memory Size:

Remark: Definition “Measurement” see chapter 6.1.2 File - Save Diagram

Search folder

Please select a folder from the list:

Offentlich -
4 /8 Computer

&, Lokaler Datentrager (C:)

s HP_RECOVERY (D)

= 0S_TOOLS (E)

3 DVD-RW-Laufwerk (F:)

59 Voll (\E0912) (G))

5 Vol? (\E012) (H:) %

Kiicken Sie auf das Symbol neben einem Ordner, um
Unterordner anzuzsigen.

[ Neuen Ordner erstelien Abbrechen

See chapter 6.1.2 File > Save Diagram ‘max’, ‘normal’, ‘min’ and ‘window’.
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6.2.4.3 Common Settings Output Values and Output OK/NOK-Evaluation

End of line character:

The desired line ending mark for the output in a file gets adjusted in this box.
Following possibilities can be selected:

CRLF : Carriage Return / Line Feed Carriage return line feed (MS-DOS, Windows)

LFCR : Line Feed / Carriage Return Line feed carriage return (Linux Console)
CR : Carriage Return Carriage return (Apple Il, Apple Mac OS up to Version 9)
LF : Line Feed Line feed (Unix-Derivate, Mac OS X)

Column separator:

The column delimiter will be read out at the first execution of the application from Windows
system control (country selection) and will be set accordingly. At each further restart of the
application, the previously adjusted delimiter will be used. Following selection is possible in this
box:

TAB : Tabulator

; : Semicolon

, : Comma

. : Point

Space : Space character

Decimal separator:
The decimal delimiter is carried out the same way as described for the column separator.

Following selection is possible in this box:
, : Comma
. Point
Remark: Supplementary changes of the country adjustments in the operating system have no
influence on the once adjusted values of this software.

Additional information show / hide:

In this group, checkmarks can be placed to add further information to the output of measured
values. The entries in the three entry boxes ‘Headline’, ‘Address’ and ‘Comment’ can be
specified arbitrarily. With the checkmark, these entries will be recorded in the output file. The
‘Uncertainty of measurement’ - if the connected sensor has one - can also be displayed in the
output file. By a checkmark in ‘Date / Time’ the measurement period can also be recorded in the
output file. By a checkmark in ‘Physical unit’ it is also possible to systematically fade in/out the
physical units in the output file.

6.2.4.4 Documentation - Additional information

Here, the free text can be found which can be activated in ‘Documentation - Output measured values >
Additional information show / hide’.
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6.2.5 Sensor Adjustment

4

@ DR-USBE-VS Lorenz Messtechnik GmbH | = | B |-
File Operating Mode View Language Help
Navigation Bar £ Sensor Adjustment
.+ File
----- E save Measvalue run user's Store uncertainty of
..... & 5ave Diagram adjustment measurement in the
& Print sensor
..... rin
----- Exit

_; Operating Mode

_ Language
.. B8 Deutsch
..2l= English

_+ Help
@ Info
LD Advice

Ready for use. Sensor connected

..... E] Meas./Diagram Mode
_; View

= Adjust. Mode
§ Sensor Connection
L. % Sensor Information

[&£] Documentation

e Digital Views
{:} Torque

3 Angle

73 Speed

b % Powver

b3 10/NIO-validation
{:} Diagram

[ Mavigation Bar
Status Bar

Reset Views

B0 Francaiz

nr

Wed 11/20/2013 02:05 PM

ke

In this dialog, a user adjustment of torque can be executed or deleted. Furthermore, the uncertainty of
measurement in % can be stored in the connected sensor. This variable - if available - shows the
application in the measurement / diagram mode and in the sensor information. The uncertainty of
measurement can also be read out in a CSV output file (see chapter 6.2.4.1 Documentation - Output
Measured Values)

Run User’s Adjustment:

With this function, a two-point adjustment of torque can be carried out. In order to read the first
point, the sensor must be completely unloaded, so that the application can detect the zero point
of the sensor and the control amplification factor. Now indicate the desired load of the sensor for
the second measuring point. The indication must be in the range of

[final value of measurement 1,3 > adjustment value > final value of measurement / 2], otherwise
the adjustment cannot be continued. The closer the adjustment value to the final value of
measurement, the more precisely the adjustment will be! If the user adjustment has been
completed successfully, it can be seen in the sensor information. Herewith, the user adjustment is
active and the proprietary adjustment is inactive. This procedure can be cancelled by deletion of
the user adjustment. Then, the proprietary adjustment is reactivated.
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o Delete User’s Adjustment:
This function irrevocably deletes the user adjustment and activates the proprietary adjustment.
The uncertainty of measurement of the user adjustment is also deleted.

e Store Uncertainty of Measurement in the Sensor:
This function allows to store a maximum value for the uncertainty of measurement in the sensor.
This value is usually determined at a proprietary or DKD calibration. If the proprietary adjustment
of the connected sensor is active and if a value for the uncertainty of measurement was indicated,
it means that the sensor had a proprietary or a DKD calibration at Lorenz Messtechnik GmbH.
Permissible values for the uncertainty of measurement are [5 % > uncertainty of measurement >
0 %]. If the sensor is connected, this value will be displayed in the ‘Meas./Diagram Mode’, in the
’Sensor Information’ and if required in the CSV-output file. This value has no influence on the
measured values.

6.3 Meas./Diagram Mode

(E) DR-USB-VS Lorenz Messtachnik GmbH = | B il
File Operating Mode View Language Help
Mavigation Bar x Meas. /Diagram Made Torque Display » | IO/NIO - Validation Display x
— File
[ Save Measvalue BicoascSiak -4_ 1 m N = m
[ Save Diagram
Measure Stoc T ¥ ¥
@ Brint easure Stop Q0mN-m ~LimN-m 41mN-m

S Trigger inactive — | i —"

4 Operating Mode 5:;'}"%%3‘:” O [¥] Trigger auto repeat
- ¢ Adjust. Mode

§ Sensor Connection
% Sensor Information Single Measurement

. [11] Measure Adjust.
....[tf] Documentation ontra O Speed Display =
.. %5 Sensor Adjustment : g
Meas./Diagram Mode Measuring speed 0 1/m|n
o View
(=1 _+ Digital Views 01imin 01imin 11min
) TWRE MIN Rssst MAX Rasst
(4 Torque Sampling rate: 2500/sec
. 7% Angle
.. Speed Serial number: 82381
.@ Power Upper range value: 10,0 N'm
10/NIO-validation Uncertainty of measurement: n.a.
Diagram - "
[ Mavigation Bar Power Display
17 Status Bar fleasyesion

Trigger active
-ow Reset Views

_ Language Rogasy Trigger auto repeat
-8 Deutsch A, o

$5 English ——

BB Francais asurement .
_ Help Measuring angle
(-G Info Control O

@ Advice

| Set angle to zero at measure start [ triggerstart-event -

Torque ., H, : : : : Sampling rate: 2500/sec
[mli-m] ; ; ; ;

200 i : : SRS SRS I Serigl number: 82381 e
- Upper range value: 10.0 N'm
Uncertainty of measurement: n.a.

LIRS It elaeletulelebet safal s Setelefebeietebuieliebutelels beleeetuieiebeebatetot ~sosbiaaiielebetalision. et

400

200-f---~50-[-------

00-f--~

T e

A0 0| - pe-

BO0 | aop |-

200! 260l 0080 : v 0 0 + + g
2000 2800 1.000 1 600 2000 2600 3000 3.600

0 +
4.000 Time [sec]l

» |4

Diagram

Ready for use. Sensor connected Wed 11/20/2013  01:03 PM

In the ‘Meas./Diagram Mode’ the digital displays of the physical variables and the diagram can be
activated. Only the displays which were check-marked in ‘Measure Adjust. > Measured variable > Type’
are active. At measuring angle this equates to torque and angle of rotation and at measuring speed it
equates to torque, speed and performance. The function which sets the ‘Angle = 0’ and the adjustment
‘Set angle to zero at measure start / triggerstart-event’ is only active at the angle of rotation
measurement (see above chart - right angle of rotation measurement with left speed measurement).

E-Mail: info@lorenz-sensors.com Technical changes under reserve 090302i.docx
Internet: www.lorenz-sensors.com Page 26 of 30



mailto:info@lorenz-sensors.com

(® LORENZ MESSTECHNIK GmbH 255 st ™' = 14 ZJZ%IS?ZSS:&]]

Each, the digital displays and the diagram are in a discrete window. These windows can be positioned to
the main window or it can freely be placed on the monitor. In order to scroll the windows, the mouse
pointer must be placed on the title bar of the respective window. By keeping the left mouse key pressed,
the window can be shifted or positioned. The contents of the window automatically adopts to the window
size. By key ‘Ctrl’ the positioning in the main window can be avoided.

Each digital display has four output fields. One each for the current measured value, the tared value, the
minimum value and the maximum value. The minimum and maximum value can be set back by the
buttons ‘MIN Reset’ and ‘MAX Reset’. If the tare-button shows "TARE’ and is kept pressed, this will set
the current measured value to zero and the tared difference will be displayed above in the output field.
Afterwards this button indicates ‘TARA=0’, thus the tare can be cancelled.

The OK/NOK display always shows the total of all defined criteria. If the criteria is met, a green indicator
appears. If at least one criterion is not met, the indicator turns red. A grey indicator means that there is
currently no evaluation, e.g. after start-up or after a new series of measurements was started.

Measure Start:
By this button, a measurement gets started. The digital displays and the diagram will be fed with
measured values after pressing this button. Unnecessary buttons are deactivated during the
measurement. In addition, the status of the application “Measuring...” is indicated in the status bar.

= Software trigger start event

Measure Stop:
Can only be used at active measurement. As soon as the button was pressed the measuring will be

stopped and will initiate possible automatic storage (see chapter 6.2.4 Documentation). At active
automatic storage into a file, the progress is shown on the status bar as well as the idle state ‘Ready for
use. Sensor connected’.

=> Software trigger stop event

Trigger:

This button activates a software triggering as explained in chapter 6.2.3.5.1 Triggering to a Physical
Variable ( M, o, n, P ). The status lamp on the side of the button blinks yellow at active triggering. By
pressing again, the triggering will be deactivated. The course of a software trigger is described in chapter
6.2.3.5 Measure Adjust. > Trigger.

Trigger LED  Condition ‘

grey Trigger OFF
flashing Trigger waits for a trigger start event.
yellow Only the digital displays are updated.
Trigger Measurement ON. Digital
green displays and diagram are updated with
values.

Trigger Auto Repeat:

By a check mark, the trigger gets reactivated as soon as all actions of the Trigger-Stop-Event are
processed (e.g. write file. See chapter 6.2.4.1 Documentation - Output Measured Values and chapter
6.2.4.2 Documentation = Output diagram)

@DActivate only if an automatic storage from 0 or 6.2.4.2 is active.

Single Measurement:
By this key, a single current measured value gets requested from the active sensor. This function can
only be carried out in the idle mode of the application.

.Control’ and .,Angle =0’:
The buttons ‘Control’ and ‘Angle = 0’ are only activated during the measurement at low sampling rates
(<20/sec) and in idle mode.
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By means of the control, the measuring bridge in the sensor gets detuned and issues the nominal range.
A red lamp next to the button indicates active control. By clicking on ‘Control’ again, it will be deactivated.

By means of the ‘Angle = 0’ button the angle value will be set to zero. This button is only visible during an
angle of rotation measurement.

Set Angle to Zero at Measure Start / Triggerstart-Event:

The user can place a checkmark here, so that at the start of a measurement through ‘Trigger’ or
‘Measure Start’, the application automatically sets the angle value to zero. This button is only visible
during an angle of rotation measurement.

7 Parameter sets

The settings in the software, which are made in the registers measuring settings, measurement and
diagram mode as well as documentation, can be combined and saved into a parameter set.

In the software, 20 memory spaces are available for parameter sets, which can be switched quickly.
All parameter sets can be imported or exported to a text file.

71 Save Parameter set

- Open the “Parameter sets” dialog via the button of register “Measurement settings”,
“Documentation” or “Measurement and Diagram mode”.
- Select a memory space in “Designation”. Free memory spaces are indicated by “-“, If
an occupied memory space is selected, it will be overwritten with the current values.
- Enter a name and confirm with OK.
- Accept the protection question.
@ Caution: The current settings are irretrievably overwritten with the
contents of the selected memory space!
- Exit the “Parameter sets” dialog.

7.2 Use Parameter set

- Open the “Parameter sets” dialog via the button of register “Measurement settings”,
“Documentation” or “Measurement and Diagram mode”.
- Select a memory space in “Name”. Free memory spaces are indicated by
be used.
- Accept the protection question.
Caution: The current settings are irretrievably overwritten with the
contents of the selected memory space!
- Exit the “Parameter sets” dialog.

and can’t

7.3 Delete Parameter set

- Open the “Parameter sets” dialog via the button of register “Measurement settings”,
“Documentation” or “Measurement and Diagram mode”.
- Select a memory space in “Name”. Free memory spaces are indicated by “-*.
- Accept the protection question.
Caution: The content of the memory space is irretrievably deleted!

- Exit the “Parameter sets” dialog

7.4 Export all Parameter sets

- Open the “Parameter sets” dialog via the button of register “Measurement settings”,
“Documentation” or “Mesaurement and Diagram mode”.
- Select a directory into which the parameter records are to be exported. A file
“ParameterSets.ixt” is created during the export.
@ Caution: If a file "ParameterSets.txt" exists in the selected
directory, it will be overwritten!
- Exit the “Parameter sets” dialog.
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7.5 Import all Parameter sets

- Open the “Parameter sets” dialog via the button of register “Measurement settings”,
“Documentation” or “Measurement and Diagram mode”.
- Select a directory from which the “ParameterSets.ixt” file shall be imported.
Caution: All parameter sets stored in the software are overwritten
with the file "Parameters.txt" from the selected directory!
- Exit the “Parameter sets” dialog.

8 User Data

A memory space is reserved on the sensors, which can be written and read as desired.

This memory is divided into 8 blocks, each with 32 bytes.

In the “User data” tab, these blocks can be written or read out.

For each block, it is possible to individually select whether the representation takes place byte-wise in
hexadecimal, or in ASCII as a character string with 32 characters. This selection is retained at the next
program start.

Hex-Representation:
Each value is represented hexadecimal in the value range 00 to FF.

ASCII-Representation:

Characters of the standard 8-bit ASCII set according Microsoft are displayed
Non-printable characters are displayed as "&"

32 characters can be entered, only.

If less than 32 characters are entered, the remaining characters are filled with zero bytes.

When changing displaying between hexadecimal and ASCII, the contents of the data blocks are not
changed.
@ Caution: The number of writing operations in the sensors may be limited. Please
observe the operating instruction of the respective sensor!
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9 Debugging

This chart helps to find frequent errors and the measures for debugging.

Error Possible Cause Debugging

Application does not start or Operating system too old Required operating system:

does not find any a sensor WIN VISTA, WIN 7, 8, 8.1, 10
No drivers for USB sensors Install the driver packet from the

product CD. Install drivers with
administrator rights, only.

Sensor is not connected to the PC Connect sensor to the PC

A newer version of the software run | Always use the newest version of
on this PC before this software

USB Hub has less power Take care your USB port
deliveres enough power.
Do not use passive USB hubs.

Sensor is not compatible Always use compatible software
Software hangs or crashes Incompatible drivers of third-party Try de-activating modems in the
during start-up products device manager.

Manually change the com port
number of Lorenz Com port in the
device manager.

10 Continuative Documents
Following documents contain reference information about the DR-USB-VS:

Software manuals:
e Document number 090302, ,Operation Manual for Configuration and Evaluation Software DR-
USB-VS* (German. 090301).
Sensor manuals:
e Document number 090307, ,, Operation Manual for ,Plug and Play’ USB Torque Sensor. For The
Type DR-3000“ (German. 090303).
e Document number 090322, ,Operation Manual for ,Plug and Play’ USB Torque Sensor. For The
Types DR-3001 and DR-3003“ (German. 090321).
Sensor data sheets:
e Document number 080713, Data sheet ,USB - Torque Sensor with Configuration and Evaluation
Software” for the types DR-3000 and DR-3000P (German. 080697).
e Document number 080739, Data sheet ,USB - Torque Sensor with Configuration and Evaluation
Software* for the type 3001 (German. 080737).
e Document number 080740, Data sheet ,USB - Torque Sensor with Configuration and Evaluation
Software* for the type 3003 (German. 080738).
Manuals for Developers:
¢ Document number 090110, Lorenz protocol ,a flexible command set for digital sensors and
interfaces”.
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